
Sequence Homology 
 

Homology is defined as similarity attributed to descend from a common ancestor, which means 

that two (or more) sequences have a common ancestor. It is a statement about evolutionary 

history. Whereas Similarity simply means that two sequences are similar, by some criterion. 

Similarity does not refer to any historical process, but compares sequences by some method. 

However, in bioinformatics these two terms are often confused and used interchangeably. The 

reason is probably that significant similarity is such a strong argument for homology. 

 

Sequence alignment 

Sequence alignment is a way of comparing the sequences of DNA, RNA, or protein for 

identifing regions of similarity that may be a consequence of functional, structural, or 

evolutionary relationships between the sequences. Aligned sequences of nucleotide or amino 

acid residues are typically represented as rows within a matrix. Gaps are inserted between the 

residues so that identical or similar characters are aligned in successive columns. 

 

Sequence Alignment Algorithms 

Given a scoring system or matrices, one may require an algorithm to find out a best optimal 

alignment for a pair of sequence. If both sequences are of same length the only possibility is 

global alignment but when one has sequences which differ in length then alignment becomes 

complicated as gaps are to be inserted for good alignment and gaps can be inserted in any 

position and one start looking for local alignments between subsequences of the two sequences. 

Computationally it’s not feasible to get all the possible best alignments. Dynamic programming 

algorithms are guaranteed to find the optimal scoring alignment or set of alignments with a given 

scoring function however, identifying a good scoring function is often an empirical rather than a 

theoretical matter. These are core to computational sequence analysis. In most cases heuristic 

methods are also been developed for similar kind of search. These are very fast, but they make 

additional assumptions and miss out the best match for some sequence pairs. Because of the log-

odds values for any amino acid pair, better alignments will have higher values and in this way 

high scores are obtained for optimal alignments. A procedure for pairwise alignment with linear 

gap scores, with cost d =-2 per gap residue is described here. However, the algorithm can be 

extended to more complex gap models.  

Dynamic Programming 

The technique of dynamic programming can be applied to produce global alignments via the 

Needleman-Wunsch algorithm, and local alignments via the Smith-Waterman algorithm. In 

typical usage, protein alignments use a substitution matrix to assign scores to amino-acid 

matches or mismatches, and a gap penalty for matching an amino acid in one sequence to a gap 

in the other. DNA and RNA alignments may use a scoring matrix, but in practice often simply 

assign a positive match score, a negative mismatch score, and a negative gap penalty. (In 

standard dynamic programming, the score of each amino acid position is independent of the 

identity of its neighbors, and therefore base stacking effects are not taken into account. However, 

it is possible to account for such effects by modifying the algorithm.) A common extension to 

standard linear gap costs, is the usage of two different gap penalties for opening a gap and for 

extending a gap. Typically the former is much larger than the latter. 
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e.g.  -10 for gap open and -2 for gap extension. Thus, the number of gaps in an alignment is 

usually reduced and residues and gaps are kept together, which typically makes more biological 

sense. Dynamic programming can be useful in aligning nucleotide to protein sequences, a task 

complicated by the need to take into account frameshift mutations (usually insertions or 

deletions). The framesearch method produces a series of global or local pairwise alignments 

between a query nucleotide sequence and a search set of protein sequences, or vice versa. 

Although the method is very slow, its ability to evaluate frameshifts offset by an arbitrary 

number of nucleotides makes the method useful for sequences containing large numbers of 

indels, which can be very difficult to align with more efficient heuristic methods. In practice, the 

method requires large amounts of computing power or a system whose architecture is specialized 

for dynamic programming. The BLAST and EMBOSS suites provide basic tools for creating 

translated alignments. Although dynamic programming is extensible to more than two sequences, 

it is prohibitively slow for large numbers of or extremely long sequences. 

(1) Needleman-Wunsch global alignment algorithm 

The main problem in pair wise alignment is to obtain the optimal global alignment between two 

sequences, allowing gaps i.e. all of x has to be aligned with all of y. The dynamic programming 

algorithms for solving this problem is know as Needleman-Wunsch algorithm. In a gapped 

alignment, a nucleic acid in x is matched either by an nucleic acid in y or by a gap and vice-

versa  

eg., the sequences GAATIC and GATIA has to be aligned according to the following scoring 

rules: starting score =0, match = 2, mismatch = -1, gap = -2  

 

1. A matrix F(i,j) indexed by i and j, one index for each sequence, where the value of F(i,j) is 

the score of the best alignment between X1…i of x, and Y1…j of y can be constructed as below. 

Matrix is initialized by F(O,O)=O, then proceeded by filling the matrix from top left to 

bottom right. According to scoring rules the path-graph can be filled further.  

 

  G A A T T C 

 0 -2 -2 -2 -2 -2 -2 

G -2  2 -1 -1 -1 -1 -1 

A -2 -1 2 2 -1 -1 -1 

T -2 -1 -1 -1 2 2 -1 

T -2 -1 -1 -1 2 2 -1 

A -2 -1 2 2 -1 -1 -1 

 

2. Make a path to each cell that maximizes the score for that cell. There are three possible ways 

to obtain best score for F(i,j) of an alignment. If F(i-l,j-l), F(i-l,j) and F(i, j-l) are known,    

F(i, j) can then be calculated. To do this, start from the upper left hand cornet and fill each 

cell according to the following rule:  

 

F(i,j)= max [F(i-l,j-l) + s(Xi , Yj ), F(i,j-l) + d, F(i-l,j) + d] 

  where,   

F(i,j)= the entry in the ith row and jth column of the path-graph.  

s(Xi , Yj ) = the score for the residues being aligned. d = gap penalty.  

F(i-l,j-l) + s(Xi, Yj) represents a diagonal move on the path graph, in which two residues 
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Xi aligned with Yj.  

F(i,j-l) + d represents a horizontal move on the path graph, in which a residue in the first 

 sequence (x) is aligned with a gap in the second sequence.  

F(i-l,j) + d represents a vertical move on the path graph, in which a residue in the second 

sequence (y) is aligned with a gap in the first sequence.  

 

The best score of (i,j) will be largest of these three options. This equation is repeatedly 

applied to fill the matrix of F(i, j) values, calculating value in bottom right hand corner of 

each square of four cells from anyone of the three values (left, above left, or above) as in 

the figure: 

 

  G A A T T C 

 0 -2 -4 -6 -8 -10 -12 

G -2 2 0 -2 -4 -6 -8 

A -4 0 4 2 0 -2 -4 

T -6 -2 2 3 4 2 0 

T -8 -4 0 1 5 6 4 

A -10 -6 -2 -1 3 4 5 

 

As F(i,j) values are filled, a pointer is kept in each cell back from which F(i,j) can be  

derived. To complete the algorithm some special boundary conditions are to be dealt with. 

Along the top row where j=0,the values F(i-1,j-1) and F(i.j-1)are not defined so the 

values F(i,0)represents alignments of a prefix of x to all gaps in y, hence one can define 

F(i,0)=id similarly for the left first column F(0.j)=jd. 

 

 

3. The value in the final cell of the matrix, is by definition the best score for an alignment of 

Xl…nand Y1…m, which is the best global alignment score of x to y, The path that leads from 

the first cell to the last cell that gives this score corresponds to the maximum-scoring 

alignment. To discover this path, trace back a path from the last cell to the first cell, using 

only transitions that maximize the score.  

 

 

  G A A T T C 

 0 -2 -4 -6 -8 -10 -12 

G -2 2 0 -2 -4 -6 -8 

A -4 0 4 2 0 -2 -4 

T -6 -2 2 3 4 2 0 

T -8 -4 0 1 5 6 4 

A -10 -6 -2 -1 3 4 5 

 

 

4. Trace the path or paths forward to give the optimal alignment. Traceback of the path of 

choices is done that has led to the final value. This is done, by building the alignment in reverse 

direction that is starting from the final cell and following the pointers path. In each traceback 

step, from the current cell (i,j) you have to move back to one of the cells (i-1,j-1), (i-1,j) and (i, j-
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1) from which the F(i,j) was derived. Simultaneously a pair of symbols are added  to the current 

alignment during this traceback process. Xi and Yj if step was tracedback to (i-1,j-1), Xi and gap 

character '-' if step was to (i-1,j) or '-' and Yj if the step was (i,j-1). At the one would have 

reached at the start of matrix, i=j=O. This traceback procedure finds out just one alignment with 

optimal score. The main reason that this algorithm works is that the score is made of sum of 

scores of best aligned independent pieces.  

  G A A T T C 

 0 -2 -4 -6 -8 -10 -12 

G -2 2 0 -2 -4 -6 -8 

A -4 0 4 2 0 -2 -4 

T -6 -2 2 3 4 2 0 

T -8 -4 0 1 5 6 4 

A -10 -6 -2 -1 3 4 5 

  G A A T T C 

  G - A T T A 

  G A A T T C 

  G A - T T A 

 

 

(2) Smith-Waterman local alignment algorithm  

The Smith-Waterman algorithm is a well-known algorithm for performing local sequence 

alignment; that is, for determining similar regions between two nucleotide or protein sequences. 

Instead of looking at the total sequence, the Smith-Waterman algorithm compares segments of 

all possible lengths and optimizes the similarity measure. A subsequence of a sequence x must 

be aligned with a subsequence of sequence y. This arises when it is suspected that two sequences 

may share common sub-regions (domains in proteins). This is most sensitive method to detect 

similarity between two very highly diverged sequences, even though they have shared 

evolutionary origin. In such cases small conserved portions with rest of the sequence could have 

accumulated due to mutation that is no longer alignable. The highest scoring alignment of 

subsequences of x and y is called the best local alignment. Local alignments are more 

meaningful than global alignments because they include patterns that are conserved in sequences.  

The steps involved in are: 

1.  To generate a path graph identical to the Needleman-Wunsch algorithm.  

2.  The minimum allowed final value of a cell is zero. This rule is expressed formally by 

including 0 as an alternative in the expression for F(i,j):  

F(i,j)= max [F(i-l,j-l) + s(xj , Yj ), F(i,j-l) + d), F(i-l,j) + d), 0]  

 
 

  G A A T T C 

 0 -0 0 0 0 0 0 

G 0 2 0 0 0 0 0 

A 0 0 4 2 0 0 0 

T 0 0 2 3 4 2 0 

T 0 0 0 1 5 6 4 

A 0 0 0 0 3 4 5 

 

Position (i,j) may be reached from (a) nowhere, with score 0, because one can always start a 

http://en.wikipedia.org/wiki/Sequence_alignment
http://en.wikipedia.org/wiki/Sequence_alignment
http://en.wikipedia.org/wiki/Nucleotide_sequence
http://en.wikipedia.org/wiki/Protein_sequence
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new local alignment (b) (i-l,j-l) with a match, adding score xi,yj to the score  

© (i-l,j) with a gap in y, subtracting d from the score or  

(d) (i,j-l) with a gap in x, subtracting d from the score  

 

 

3.  Find the cell with the highest score. Trace back the path and stop just before a cell with a 

score of zero reached. The longest path obtained by this rule represents the optimal    

alignment. 

 

  G A A T T C 

 0 0 0 0 0 0 0 

G 0 2 0 0 0 0 0 

A 0 0 4 2 0 0 0 

T 0 0 2 3 4 2 0 

T 0 0 0 1 5 6 4 

A 0 0 0 0 3 4 5 

 

Note: in this example, although there were two optimal global alignment paths, there is only one 

optimal local alignment path, because one of the local paths is truncated by terminating in a zero. 

In general, there may be more than one optimal local alignment path and the program will 

choose one of them arbitrarily. Also, in our case the local alignment terminates on the first 

residue of both sequences. This need not be the case.  

 

4.  Trace the path forward to give the optimal alignment: 

  G A A T T C 

 0 0 0 0 0 0 0 

G 0 2 0 0 0 0 0 

A 0 0 4 2 0 0 0 

T 0 0 2 3 4 2 0 

T 0 0 0 1 5 6 4 

A 0 0 0 0 3 4 5 

  G A A T T  

  G A - T T  

 

The alignment can end anywhere in the matrix, for the best score one can take the highest value 

F(i,j) over the whole matrix, and traceback from there till it meets zero which corresponds to the 

start of alignment. Just based on the sequence lengths the long matches between entire unrelated 

sequences will have the high scores. As a consequence although the algorithm is local alignment, 

the maximal scoring alignments would be nearly global. In this way a true subsequence 

alignment would likely be masked by a longer incorrect alignment, because of length.  

 

 

(3) Pairwise Sequence Alignment 

This method is used to find the best-matching piecewise (local) or global alignments of two 

query sequences. Pairwise alignments can only be used between two sequences at a time, but 

they are efficient to calculate and are often used for methods that do not require extreme 
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precision (such as searching a database for sequences with high similarity to a query). The three 

primary methods of producing pairwise alignments are dot-matrix methods, dynamic 

programming, and word methods; however, multiple sequence alignment techniques can also 

align pairs of sequences. Although each method has its individual strengths and weaknesses, all 

three pairwise methods have difficulty with highly repetitive sequences of low information 

content - especially where the number of repetitions differ in the two sequences to be aligned. 

One way of quantifying the utility of a given pairwise alignment is the 'maximum unique match', 

or the longest subsequence that occurs in both query sequence. Longer MUM sequences 

typically reflect closer relatedness. 

 

DotPlot  

It is a simple, graphical way of displaying sequence similarity. One can use it to easily spot 

segments of good sequence similarity. The two sequences are placed on each side of 2-

dimensional matrix, and each cell in the matrix is then filled with a value for how well a short 

window of the sequences match at that point. 

 

 

 
 

There are many online tools are available for the Pairwise sequence alignments. 

EMBOSS- Pairwise Alignment Algorithms 

EMBOSS is "The European Molecular Biology Open Software Suite". EMBOSS is an Open 

Source software analysis package specially developed for the needs of the molecular biology. 

This software automatically copes with data in a variety of formats and even allows transparent 

retrieval of sequence data from the web. Also, as extensive libraries are provided with the 

package. This software is available in both offline and online version, offline version is 

command-line based software which we use without internet access too which can be 

downloaded from the given link http://www.interactivebiosoftware.com/embosswin/embosswin-

0.8-setup.exe.  But, online version is a Graphical User interface which is more easier and user-

friendly.  

Installation: 

The installation of the EMBOSS can be done by double clicking on the EMBOSSwin Setup 

downloaded from http://www.interactive-biosoftware.com/embosswin/embosswin-0.8-setup.exe. 

 

Uses of the EMBOSS: 

 Sequence alignment 

http://www.interactivebiosoftware.com/embosswin/embosswin-0.8-setup.exe
http://www.interactivebiosoftware.com/embosswin/embosswin-0.8-setup.exe
http://www.interactive-biosoftware.com/embosswin/embosswin-0.8-setup.exe
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 Rapid database searching with sequence patterns 

 Protein motif identification, including domain analysis 

 Nucleotide sequence pattern analysis 

 Codon usuage analysis for small genomes 

 Rapid identification of sequence pattern in large scale sequence sets 

 Presentation tools for publication, and much more. 

EMBOSS has several important advantages:  

 A properly constructed toolkit for creating robust bioinformatics applications or 

workflows.  

 A comprehensive set of sequence analysis programs.  

 All sequence and many alignment and structural formats are handled. 

 Extensive programming library for common sequence analysis tasks. 

 Additional programming libraries for many other areas including string handling, pattern-

matching, list processing and database indexing. 

 It is open-source. 

 Each application has the same style of interface so master one and you've mastered them 

all.  

 The consistent user interface facilitates GUI designers and developers. 

 It integrates other popular publicly available packages. 

 It is free of arbitrary size limits: there are no limits on the amount of data that can be 

processed. For the programmer, memory management for objects such as sequences and 

arrays is simplified.  

 

 
 

EMBOSS tool is used to compare 2 sequences.  

 An alignment that covers the whole length of both sequences, it is  recommended to use 

needle and, 

 An alignment which is used to find the best region of similarity between two sequences, 

it is recommended to use water. 
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PROGRAM: NEEDLE 

This program uses the Needleman-Wunsch global alignment algorithm to find the optimum 

alignment (including gaps) of two sequences when considering their entire length.  

The Needleman-Wunsch algorithm is a member of the class of algorithms that can 

calculate the best score and alignment in the order of mn steps, (where 'n' and 'm' are the 

lengths of the two sequences). These dynamic programming algorithms were first 

developed for protein sequence comparison by Needleman and Wunsch, though similar 

methods were independently devised during the late 1960's and early 1970's for use in the 

fields of speech processing and computer science.  

What is the optimal alignment? Dynamic programming methods ensure the optimal 

global alignment by exploring all possible alignments and choosing the best. It does this 

by reading in a scoring matrix that contains values for every possible residue or 

nucleotide match. Needle finds an alignment with the maximum possible score where the 

score of an alignment is equal to the sum of the matches taken from the scoring matrix. 

An important problem is the treatment of gaps, i.e., spaces inserted to optimize the 

alignment score. A penalty is subtracted from the score for each gap opened (the 'gap 

open' penalty) and a penalty is subtracted from the score for the total number of gap 

spaces multiplied by a cost (the 'gap extension' penalty). Typically, the cost of extending 

a gap is set to be 5-10 times lower than the cost for opening a gap.  

Needle  

This is a true implementation of the Needleman-Wunsch algorithm and so produces a full 

path matrix. It therefore cannot be used with genome sized sequences unless you've a lot of 

memory and a lot of time. Needle is for aligning two sequences over their entire length. This 

works best with closely related sequences. If you use needle to align very distantly-related 

sequences, it will produce a result but much of the alignment may have little or no biological 
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significance. A true Needleman Wunsch implementation like Needle needs memory 

proportional to the product of the sequence lengths. For two sequences of length 10,000,000 

and 1,000 it therefore needs memory proportional to 10,000,000,000 characters. Two arrays 

of this size are produced, one of integers and one of floats so multiply that figure by 8 to get 

the memory usage in bytes. That doesn't include other overheads. Therefore only water and 

needle are used for accurate alignment of reasonably short sequences.  

PROGRAM: WATER  

Water uses the Smith-Waterman algorithm (modified for speed enhancements) to calculate the 

local alignment.  

Water is a true implementation of the Smith-Waterman algorithm and so produces a full path 

matrix. It therefore cannot be used with genome sized sequences unless it has a lot of 

memory and a lot of time. Local alignment methods only report the best matching areas 

between two sequences - there may be a large number of alternative local alignments that do 

not score as highly. If two proteins share more than one common region, for example one has 

a single copy of a particular domain while the other has two copies, it may be possible to 

"miss" the second and subsequent alignments. You will be able to see this situation if you 

have done a dotplot and your local alignment does not show all the features you expected to 

see. Water is for aligning the best matching subsequences of two sequences. It does not 

necessarily align whole sequences against each other; you should use Needle if you wish to 

align closely related sequences along their whole lengths. A true Smith Waterman 

implementation like Water needs memory proportional to the product of the sequence lengths. 

For two sequences of length 10,000,000 and 1,000 it therefore needs memory proportional to 

10,000,000,000 characters. Two arrays of this size are produced, one of integers and one of 

floating point (real) numbers so multiply that figure by 8 to get the memory usage in bytes. 

That doesn't include other overheads. Therefore only use water and needle for accurate 

alignment of reasonably short sequences.  

Steps to perform 

(1) Sequences can be pasted into the large text window or can also upload a file.  

 

 
Input sequences  

Sequences can be pasted into the large text window. It is recommended that sequences less than 

10,000 characters in length should be submitted. A free text (raw) sequence is simply a block of 
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characters representing a DNA/RNA or Protein sequence. We may also paste a sequence in GCG, 

FASTA, EMBL, GenBank, PIR, NBRF, Phylip or Swiss-Prot format. Partially formatted 

sequences will not be accepted. In fasta format, do not leave a space at the start of a sequence 

header before the ">" symbol, or end this line with a full stop.  

Upload a file 

A file can be uploaded from the computer which contains a valid sequence in any format (GCG, 

FASTA, EMBL, GenBank, PIR, NBRF, Phylip or Swiss-Prot) using this option.  

 

(2) Parameters  

 Matrix: 

For protein sequences: EBLOSUM62 is used for the substitution matrix.  

 

 
 

Needle Results: (Global Alignment) 
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For nucleotide sequences:  EDNAMAT is used. Others can be specified for more or 

less sensitive alignments.  

 

 

 
 
 

Water Results: (Local Alignment) 
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(3) Molecule type  

In order to choose from the correct set of matrices the molecule type (DNA or PROTEIN) must 

be chosen.  

 

Default Gap Penalties  

  Protein  DNA 

program Gap Open Gap Extend Gap Open Gap Extend 

water 10.0 0.5 10.0 0.5 

needle 10.0 0.5 10.0 0.5 

The %id(identity) is the percentage of identical matches between the two sequences over the 

reported aligned region.  

The %similarity is the percentage of matches between the two sequences over the reported 

aligned region where the scoring matrix value is greater or equal to 0.0.  

The Overall %id(identity) and Overall %similarity are calculated in a similar manner for the 

number of matches over the length of the longest of the two sequences.  

 

Multiple Sequence Alignments(MSA) 

 

Multiple sequence alignment(MSA) is an extension of pairwise alignment to incorporate more 

than two sequences at a time. Multiple alignment methods try to align all of the sequences in a 

given query set. These are often used for(MSA) identifying conserved sequence regions across a 

group of sequences hypothesized to be evolutionarily related. Such conserved sequence motifs 

can be used in conjunction with structural and mechanistic information to locate the catalytic/ 

active sites of enzymes. MSA is also used to aid in establishing evolutionary relationships by 

constructing phylogenetic trees 

(a) Dynamic Programming: The technique of dynamic programming is theoretically 

applicable to any number of sequences; however, because it is computationally expensive in 

both time and memory, it is rarely used for more than three or four sequences in its most basic 

form.  
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(b) Progressive Methods: Progressive, hierarchical, or tree methods generate a multiple 

sequence alignment by first aligning the most similar sequences and then adding successively 

less related sequences or groups to the alignment until the entire query set has been incorporated 

into the solution. The initial tree describing the sequence relatedness is based on pairwise 

comparisons that may include heuristic pairwise alignment methods similar to FASTA. 

Progressive alignment results are dependent on the choice of "most related" sequences and thus 

can be sensitive to inaccuracies in the initial pairwise alignments. Most progressive multiple 

sequence alignment methods additionally weight the sequences in the query set according to 

their relatedness, which reduces the likelihood of making a poor choice of initial sequences and 

thus improves alignment accuracy.Many variations of the Clustal methods are used for multiple 

sequence alignment, phylogenetic tree construction, and as input for protein structure prediction. 

A slower but more accurate variant of the progressive method is known as T-Coffee; 

implementations can be found at ClustalW and T-Coffee 

 

(c) Iterative Methods: Iterative methods attempt to improve on the weak point of the 

progressive methods, the heavy dependence on the accuracy of the initial pairwise alignments. 

Iterative methods optimize an objective function based on a selected alignment scoring method 

by assigning an initial global alignment and then realigning sequence subsets. The realigned 

subsets are then themselves aligned to produce the next iteration's multiple sequence alignment.  

 

Clustal   

Clustal comes in two flavors: the command-line version   ClustalW and the graphical version 

ClustalX. Precompiled executables for Linux, Mac OS X and Windows (incl. XP and Vista) of 

the most recent version (currently 2.0.12) along with the source code are available for 

download.Clustal also has been incorporated in web servers for online applications.  

 EBI web server  

 Swiss Institute of Bioinformatics  

(i) ClustalW 

It is a Multiple Sequence Alignment program for DNA or Protein. It produces biologically 

meaningful multiple sequence alignments of divergent sequences. It calculates the best match for 

the selected sequences and lines them up so that the identities, similarities and differences can be 

seen. Evolutionary relationships can be seen via viewing Cladrograms or Phylograms. 

 

Steps to perform 

 

1. Type the following address in the address bar http://www.ebi.ac.uk/Tools/clustalw/   and 

we get the page as shown below. 

 

http://www.ebi.ac.uk/Tools/clustalw/
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2. Paste the number of sequences or we can upload the file in the space provided.  

 

 
 

3. Click on the run button. 
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4. After clicking on the run button, we will get the following: 

 

 
 

5.  And then we get the ClustalW results as shown below: 

 
 

Output of the ClustalW: 

 

Number of sequences:  It will show how many sequences we have taken for the analysis 

 

Alignment Score: Alignment score is a matching score used in the definition of the sequence 

identity  

 

* Residues/nucleotides in column are identical in all sequences in the alignment. 

:   Conserved substitutions have been observed. 

.   Semi-conserved substitution is observed. 

 

Sequence type: Whether the sequence is DNA or Protein. 
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JalView: It will give us the preview of the result as shown below: 

 

 
 

It will generate four types of result files. 

 Output file: 

 
 

The result of the following file is as shown below: 
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 Alignment file: It will generate the multiple sequence alignments between all the 

sequences we have taken for the analysis. 

 
 

The result of the following file is as shown below: 

 

 
 

Guide tree file: It is calculated based on the distance matrix i.e. generated from “Pairwise 

scores.” The output can be found in the .dnd file. It will generate the phylogenetic tree file 

between the chosen sequences. 

 

 
 

The result of the following file is as shown below 
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Score Table: It is a new view to ClustalW output. Users can sort the scores by Alignment Score, 

Sequence Number, Sequence Name and Sequence Length. It is shown as below: 

 

 
 

Results can be shown in two different formats like: 

Show as phylogram, and Show as cladogram 

 

Phylogram: It is a branching diagram assumed to be an estimate of a phylogeny, branch lengths 

are proportional to the amount of the inferred evolutionary changes. 

 

Cladogams: It is a branching diagram assumed to be an estimate of a phylogeny where the 

branches are of equal lengths, thus cladograms show common ancestry, but do not indicates the 

amount of evolutionary time. 

 

.dnd file: It is a file that describes phylogenetic tree. 

 

(ii) ClustalX 

 

It is a window based graphical user interface for the ClutalW multiple sequence alignment 

program. It provides an integrated environment for performing multiple sequence and profile 

alignment and analyzing the results. In order to make a multiple sequence alignment using 

ClustalX, sequences has to be in FastA format. Clustal performs a global-multiple sequence 

alignment by the progressive method.  

The steps include: 

a) Perform pair-wise alignment of all the sequences by dynamic programming 

b) Use the alignment scores to produce a phylogenetic tree by neighbor-joining 

c) Align the multiple sequences sequentially, guided by the phylogenetic tree 
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The closely related sequences aligned first followed by the additional sequences and then groups 

of other sequences are added and producing a multiple sequence alignment. As more sequences 

are added to the profile, gaps accumulate and influence the alignment of further sequences. It 

calculates gaps and place them in between conserved domains. New gaps are then introduced 

into the multiple alignment when more sequences are added, but gaps can never be deleted, only 

added.  

Clustal has advanced options: 

a) Add sequences with weight 

b) Add weights to different sequence positions 

c) Add a sequence or alignment to an alignment 

d) Use user-defined tree for alignment 

 

Steps to perform 

(1) Click on the clustal-X icon, the following window will appear. 

 

 
 

(2) Click on the File-menu, and choose Load Sequences menu item. Sequences must be in 

FASTA format. 

 

 
 

The left panel shows the list of sequences according to the name that follows,“>”symbol in the 

input file. The right pane shows the beginning of each sequence.  
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Alignment parameters 

1. Reset All Gaps (Alignment->Alignment parameters, Edit->Remove all Gaps) 

2. Refine Pairwise Alignment Parameters (Alignment->Alignment parameters) 

3. Refine Multiple Alignment Parameters (Alignment->Alignment parameters) 

4. Refine Output Format Options (Alignment->Output Format Options) 

5. Write Alignment as Postscript (File->Write Alignment as Postscript) 

6. Assess the quality of the alignment 

a. Not satisfied -> Go to step 1. 

b. Satisfied -> Refine the alignment by hand 

 

Pairwise alignment parameters 

To create a pairwise alignment, it  needs to know what penalties to assign for the creation of a 

gap and for the extension of that gap.  

 Choose Pairwise Alignment Parameters from the Alignment-menu. We will see a dialog 

box like the one below. 

 

 
 

Pairwise Alignments:It allows us to choose between Slow-Accurate and Fast-Approximate 

methods.  

Gap Opening and Gap Extension. Decreasing the gap penalties will allow the introduction of 

more gaps, and less mismatches. This may result is matches that do not reflect homology 

(identity by descent). Increasing gap penalties wil have an opposite effect, but may result in 

missing matches that actually are homologies. 

Position Weight matrix: The Protein Weight Matrices are equivalent to the same matrices used as 

evolutionary models in the production of the dendrogram. All the matrices have their strenghts 

and down-sides: PAM has been used for years, but is now somewhat outdated, and the Gonnet 

can be more appropriate. BLOSUM seems to be best for searching databases. 

 

A matrix can be created into ClustalX as shown below: 
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For amino acids: 

char *amino_acid_order = "ABCDEFGHIKLMNPQRSTVWXYZ"; 

short blosum30mt[]={ 
4, 

0, 5, 

-3, -2, 17, 

0, 5, -3, 9, 

0, 0, 1, 1, 6, 

-2, -3, -3, -5, -4, 10, 

0, 0, -4, -1, -2, -3, 8, 

-2, -2, -5, -2, 0, -3, -3, 14, 

0, -2, -2, -4, -3, 0, -1, -2, 6, 

0, 0, -3, 0, 2, -1, -1, -2, -2, 4, 

-1, -1, 0, -1, -1, 2, -2, -1, 2, -2, 4, 

1, -2, -2, -3, -1, -2, -2, 2, 1, 2, 2, 6, 

0, 4, -1, 1, -1, -1, 0, -1, 0, 0, -2, 0, 8, 

-1, -2, -3, -1, 1, -4, -1, 1, -3, 1, -3, -4, -3, 11, 

1, -1, -2, -1, 2, -3, -2, 0, -2, 0, -2, -1, -1, 0, 8, 

-1, -2, -2, -1, -1, -1, -2, -1, -3, 1, -2, 0, -2, -1, 3, 8, 

1, 0, -2, 0, 0, -1, 0, -1, -1, 0, -2, -2, 0, -1, -1, -1, 4, 

1, 0, -2, -1, -2, -2, -2, -2, 0, -1, 0, 0, 1, 0, 0, -3, 2, 5, 

1, -2, -2, -2, -3, 1, -3, -3, 4, -2, 1, 0, -2, -4, -3, -1, -1, 1, 5, 

-5, -5, -2, -4, -1, 1, 1, -5, -3, -2, -2, -3, -7, -3, -1, 0, -3, -5, -3, 20, 

0, -1, -2, -1, -1, -1, -1, -1, 0, 0, 0, 0, 0, -1, 0, -1, 0, 0, 0, -2, -1, 

-4, -3, -6, -1, -2, 3, -3, 0, -1, -1, 3, -1, -4, -2, -1, 0, -2, -1, 1, 5, -1, 9, 

0, 0, 0, 0, 5, -4, -2, 0, -3, 1, -1, -1, -1, 0, 4, 0, -1, -1, -3, -1, 0,2,4}; 

/* 

 

For the DNA: 

char *nucleic_acid_order = "ABCDGHKMNRSTUVWXY"; 

short clustalvdnamt[]={ 

10, 

0, 0, 

0, 0, 10, 

0, 0, 0, 0, 

0, 0, 0, 0, 10, 

0, 0, 0, 0, 0, 0, 

0, 0, 0, 0, 0, 0, 0, 

0, 0, 0, 0, 0, 0, 0, 0, 

0, 0, 0, 0, 0, 0, 0, 0, 0, 

0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 

0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 

0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 10, 

0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 10, 

0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 

0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 

0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 

0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0}; 
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Multiple alignment parameters: 

Choose Multiple Alignment Parameters from the Alignment-menu. A new dialog box 

will appear. 

 
 

DNA transition weight can be modified. Weight 0 means that transitions are scored as 

mismatches, and weight 1 mean that transitions are given the same weight as transversions. For 

distantly related DNA sequences, the weight should be near to zero; for closely related sequences 

it can be useful to assign a higher score. 

 

Alignment output-format 

When ClustalX creates an alignment it writes the aligned sequences into a file. There are 

different multiple alignment formats, which might be needed depending on what program is 

planned to use for further analyses. The output-format can be modified by selecting the Output 

Format Options menu item 

form the Aligment-menu. 

 

Creating the alignment 

For aligning the sequences3. Choose the Do Complete Alignment under the alignment menu. 

After the alignment is done, the main window will be updated with the aligned sequences. 
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The bases are colored, which makes the assessment of alignment that much easier. The 

histogram (or line) below the ruler indicates the degree of similarity. Peaks indicate positions of 

high similarity, and valleys positions of low similarity. 

 

The grey line just above the sequences is used to mark strongly conserved positions. The “*” 

character indicates positions that have been fully conserved. 

 

Go to File-menu and select Write Alignment as Postscript. A dialog box opens. 

 

 
 

Optional parameters can be set by the user  

 The OK button is to be clicked after parameter setup. 

 The resulted Ghost script file can be opened in GSview 
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Assessing the quality of the alignment 

In practice, many alignments are produced, and they are compared together. You can start by 

using the default ClustalX options for pairwise and multiple alignment options. In the next 

alignments try lowering and highering the gap options by 50%. Produce, say 10-20 different 

alignments, and then compare those together. Often you need to try more than 10 different 

settings in order to find the best alignment. What you also need to keep in mind is that alignment 

is not an absolute thing. It is a best guess according to some algorithm used by a computer 

program or by an experienced human eye. It is necessary for the user to carefully examine each 

alignment to see if it makes biological sense. There are some guidelines on how to assess the 

quality. First similarityis to be maximized and dissimilarity is to be minimized. Therefore, the 

number of gaps is one parameter which is to be paid . Histogram can be used  in the bottom of 

the alignment and the “*” characters above it to assess the conservation of different areas of the 

alignment. 

 

Advanced options 

(a)  Do alignment from the guide tree 

If we have some data on the relationships of the sequences, we can construct a tree in 

the Newick-format, and use that for producing a multiple sequence alignment. 

Produce a tree like the one below: 

(( 

Pan_verus1:0.02428, 

Pan_verus2:0.01474) 

:0.03203, 

( 

Pan_velle1:0.00437, 

Pan_velle2:0.00579) 

:0.01402, 

( 

Pan_trog1:0.00306, 

Pan_trog2:0.00306) 

:0.05015); 

 

(b)  Save the tree in a file in text-format. 

In Clustal, The Do Alignment From Guide Tree from the Alignment menu should be selected to 

get alignment tree.Thisway we can try to get around the difficulties of the progressive alignment, 

which mightcreate wrong alignments, if the sequences are very divergent. This can also be used 

to combine morphological data into the sequence alignment step: the knowledge of the 

relationships  of the taxons can be used to guide the alignment process.  

 

©  Profile alignment:  

There is a pull-down menu on the main window top left-hand corner. From the menu change to 

Profile Alignment Mode. The Alignment view window is now split into two parts. The upper 

part contains the alignment we just created, and lower is empty. The upper part is called “profile 

1” and the lower part is “profile 2”. In the File-menu we have the options to load profiles 1 and 2. 

Now we already have the profile one available, so we only need to load the profile 2.. The main 

window is updated, as follows: 
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From the alignment-menu, select first the option “Align Sequences to Profile 1” is to be selected. 

After then “Align Profile 2 to Profile 1”. This will create an alignment file, where all the 

sequences are together.  

 

(d)  Using secondary structure information in the profile alignment 

The sequence alignment can be guided by the secondary structure of the protein, if such 

information is available. In ClustalX the gap penalties are raised at core alpha helix (A) or beta 

strand (B)residues. The structure information can be used only in the Profile Alignment Mode. 

These gap penalties cannot be used in the multiple alignment mode. Then the penalties are 

adjusted in the ClustalX dialog box. First we need to create the input files. In the first input file, 

which the first sequence of all the sequences to aligned, a descriptions of the domains (helix or 

strand) is included. The second input file contains the rest of the sequences in the FastA-format. 

The information about the domains is most easily acquired from the SWISS-PROT descriptions. 

Copy those lines into a text file (i.e., into Notepad) and save the file  
 
ID XRC1_HUMAN STANDARD; PRT; 633 AA. 

FT HELIX 315 403 BRCT 1. 

FT HELIX 538 629 BRCT 2. 

SQ SEQUENCE 633 AA; 69525 MW; 30CC2421345ABFC2 CRC64; 

MPEIRLRHVV SCSSQDSTHC AENLLKADTY RKWRAAKAGE KTISVVLQLE KEEQIHSVDI 

GNDGSAFVEV LVGSSAGGAG EQDYEVLLVT SSFMSPSESR SGSNPNRVRM FGPDKLVRAA 

AEKRWDRVKI VCSQPYSKDS PFGLSFVRFH SPPDKDEAEA PSQKVTVTKL GQFRVKEEDE 

SANSLRPGAL FFSRINKTSP VTASDPAGPS YAAATLQASS AASSASPVSR AIGSTSKPQE 

SPKGKRKLDL NQEEKKTPSK PPAQLSPSVP KRPKLPAPTR TPATAPVPAR AQGAVTGKPR 

GEGTEPRRPR AGPEELGKIL QGVVVVLSGF QNPFRSELRD KALELGAKYR PDWTRDSTHL 

ICAFANTPKY SQVLGLGGRI VRKEWVLDCH RMRRRLPSRR YLMAGPGSSS EEDEASHSGG 

SGDEAPKLPQ KQPQTKTKPT QAAGPSSPQK PPTPEETKAA SPVLQEDIDI EGVQSEGQDN 

GAEDSGDTED ELRRVAEQKE HRLPPGQEEN GEDPYAGSTD ENTDSEEHQE PPDLPVPELP 

DFFQGKHFFL YGEFPGDERR KLIRYVTAFN GELEDYMSDR VQFVITAQEW DPSFEEALMD 

NPSLAFVRPR WIYSCNEKQK LLPHQLYGVV PQA 

 

The ID line gives description of the sequence and what it codes.  

The FT lines describe what kind of domains are present in the protein. Those should say either 

helix or strand.  

The SQ line gives molecular weight and some other information of the succeeding amino acid 

sequence. 
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For checking the secondary structures  
AA |MPEIRLRHVVSCSSQDSTHCAENLLKADTYRKWRAAKAGEKTISVVLQLEKEEQIHSVDI| 

PHD sec | EEEEEEEEEE HHHHHHHHH HHHHHHHHHHH EEEEEE EEEEE | 

Rel sec |993678997772578764999998651136878999946883699885235453354451| 

detail: 

prH sec |000000000000000116899988764467888899962100000000001111000000| 

prE sec |006778898875210000000000000000000000000003799886431212566664| 

prL sec |993210001114688872000001225432111000027886200012557665322225| 

subset: SUB sec |LL.EEEEEEEE.LLLLL.HHHHHHHH...HHHHHHHH.LLL.EEEEEE..L.L..E..E.| 

accessibility 3st: P_3 acc | eebebebbbbbbeeebeebbeebbebee ebebbeeeeebbbbbbebeeeeebbbbeb| 

10st: PHD acc |397060600000099707600770070774570600777770000006067776000060| 

Rel acc |002325036846201120058314433100121164412342639850325320404504| 

subset: SUB acc |.....b..bbbb.......bb..bb.........bbe...e.b.bbb...e...b.bb.b| 
 

The line marked with AA gives the original sequence, and the the next line, starting with PHD 

sec gives the predicted secondary structures. Rel sec gives the reliability of the secondary 

structure prediction. H mean helix, and E mean sheet. This information can be used for the 

description of the structures for ClustalX input.  As the first input file,the second file should 

include the other sequences of interest. 

 Clustal X is to be opened in profile alignment mode 

 

                         
If we have formatted the files as described above, but ClustalX does not recognize the weights, 

go to Alignment->Alignment Parameters->Secondary Structure parameters. From the opening 

dialog box turn the Use Profile Secondary Structure option on (yes). After that try to load the 

first input file again. If the loading was successful, go to Alignment->Alignment Parameters-

>Secondary Structure parameters. A dialog box opens.  

 
 

In the first input file you have set up the areas of protein consisting of helixes and strands. In the 

box you can set the gap penalties for these areas. The penalties are multiples of the normal 
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penalty given by the Multiple Sequence Alignment Parameters.After setting up the parameters, 

load in the second Profile (File->Load Profile 2). The alignment is then done in two phases as 

previously described: First align sequences to the profile 1, and then align profile 2 to profile 1. 

A new multiple alignment is created, and the gaps are more often inserted into the areas outside 

the described secondary structures than within them, depending on the parameters. 

 

Structural Alignments 

Structural alignments, which are usually specific to protein and sometimes RNA sequences, uses 

the information about the secondary and tertiary structure of the protein or RNA molecule to 

assist in the alignment of the sequences. It can be used for two or more sequences and produces 

local alignments, because they depend on the availability of structural information, it can only be 

used for sequences whose structures are known (usually through X-ray crystallography or NMR 

spectroscopy). Because both protein and RNA structure is more evolutionarily conserved than 

sequence, structural alignments can be more reliable between sequences that are very distantly 

related and that have diverged so extensively that sequence comparison cannot reliably detect 

their similarity. Structural alignments are used as the gold standard in evaluating alignments for 

homology-based protein structure prediction because they explicitly align regions of the protein 

sequence that are structurally similar rather than relying exclusively on sequence information. 

However, clearly structural alignments cannot be used in structure prediction because at least one 

sequence in the query set is the target to be modeled, for which the structure is not known. It has 

been shown that, given the structural alignment between a target and a template sequence, highly 

accurate models of the target protein sequence can be produced; a major stumbling block in 

homology-based structure prediction is the production of structurally accurate alignments given 

only sequence information. 

(1)  DALI: The DALI method (distance matrix alignment) is a fragment-based method for 

constructing structural alignments based on contact similarity patterns between successive 

hexapeptides in the query sequences. It can generate pairwise or multiple alignments and identify 

a query sequence's structural neighbors in the Protein Data Bank (PDB). It is used to construct 

the FSSP structural alignment database (Fold classification based on Structure-Structure 

alignment of Proteins, or Families of Structurally Similar Proteins).  

(2)  SSAP: SSAP (sequential structure alignment program) is a dynamic programming-based 

method of structural alignment that uses atom-to-atom vectors in structure space as comparison 

points. It has been extended since its original description to include multiple as well as pairwise 

alignments, and has been used in the construction of the CATH (Class, Architecture, Topology, 

Homology) hierarchical database classification of protein folds. The CATH database can be 

accessed at CATH Protein Structure Classification 

(3)  Combinatorial extension: The combinatorial extension method of structural alignment 

generates a pairwise structural alignment by using local alignment short fragments of the two 

proteins being analyzed and then assembles these fragments into a larger alignment. Based on 

measures such as rigid-body root mean square distance, residue distances, local secondary 

structure, and surrounding environmental features such as residue neighbor hydrophobicity, local 

alignments called "aligned fragment pairs" are generated and used to build a similarity matrix 
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representing all possible structural alignments within predefined cutoff criteria. A path from one 

protein structure state to the other is then traced through the matrix by extending the growing 

alignment one fragment at a time. The optimal such path defines the combinatorial-extension 

alignment.  
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